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Preface

We recommend that you read and understand everything in this manual 
before setting up and using the product. However, we recognize that users 
have different styles of learning. Therefore, we have designed this manual 
to be used either as a how-to procedural manual or a reference guide to 
important data.

The following conventions have been adopted to provide clarity and ease 
of use:

• Times 10-point all-caps is used to highlight the following items:

– commands, displayed messages

– menu selections, pop-up lists, button, fields, or dialog boxes 

– modes

– pins and ports

– program or application name

– instructions, registers, signals and subroutines

– an action performed by the software

– icons

• Courier Regular 10-point is used to highlight the following 
items

– bit

– software code

– file names and paths

– hexadecimal value
UM002202-1001   Preface
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• Grouping of Actions Within a Procedure Step

Actions in a procedure step are all performed on the same window or 
dialog box. Actions performed on different windows or dialog boxes 
appear in separate steps.
UM002202-1001   Preface
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Follow the precautions listed below to avoid permanent damage to the 
emulator.

1. Always use a grounding strap to prevent damage resulting from 
electrostatic discharge (ESD).

2. Power-Up Precautions.

a. Ensure that all power to the emulator and the target application (if 
any) is turned OFF.

b. Connect the target pod to the target application (if any).

c. Power up the emulator, then press the RESET button.

d. Power up the target application (if any).

3. Power-Down Precautions.

When powering down, follow this procedure in the precise order 
shown below:

a. Halt emulation.

b. In ZDS select Reset from the Build or Debug Menu.

c. Power down the target application board (if any).

d. Remove the target pod.

e. Power down the emulator.

Electrical Safeguards
Preface   UM002202-1001
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1. Refer to the “Precaution List” section of the Product Information 
sheet for additional operating precautions specific to various devices.

2. Do not leave the emulator powered up with the RS-232C cable 
connected to a powered-down PC.

3. Before inserting target pod into target application board, refer to 
Chapter 2 to determine appropriate jumper selections and options.

Notes:
UM002202-1001   Preface
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1 Introduction

OVERVIEW

Congratulations for selecting a fine development tool! The Z86C36 
ICEBOX provides in-circuit emulation for the Z8 family of UART 
controllers. The ICEBOX consists of an emulation daughter board that is 
plugged into a 32-MHz motherboard using P1 and P2 headers. The 
Z86C50 ICE chip is used as the emulation processor for devices with less 
than or equal to 32K of code memory. The Z86C51 ICE chip is used as 
the emulation processor for devices with 64K of code memory, that is, 
Z86C36 and Z86C46. 

The 32 MHz motherboard has been modified for 64 K operation and 
provides host communication interface, control processor, I/O space 
decoding, and LED indicator. The ICEBOXes are designed to be used 
with ZiLOG Developers Studio, giving the user a total package to write, 
edit, and debug their applications.

ICEBOX FEATURES

Key features of the Z86C36 ICEBOX include:

• Supports up to 64 K of ROM 

• The capability to vary the operating voltage from 3.0–5.0 V 

• Supports in-circuit emulation on target systems that operate from 
3.0–5.5 V

• The user can choose to power the Ice chip from either the ICEBOX or 
target board

• Supports UART devices that operate up to 16.384 MHz
UM002202-1001   Introduction
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• Emulates and supports all the features and functions for a specified 
Z8 UART microcontroller

• Multitasking allows the user to use other Windows applications while 
ZiLOG Developer Studio (ZDS) is running

Supported ZiLOG Devices

Table 1 shows products supported by the Z86C5020GSE ICE chip. 
Table 2 shows the products supported by the Z86C5120GSE ICE chip.

Table 1.  Z86C5020GSE ICE Chip Supported Products (Z86C3500ZEM 
Target Emulator Selection)

Packages Emulation OTP Required Accessories

28 PDIP Z86C34–C35 N/A 28 PDIP emulation pod

28 SOIC Z86C34–C35 N/A 28 PDIP emulation pod and a DIP to SOIC 
conversion adapter from Emulation Technology 
(AS-DIP-6-028-S003-1 or AS-DIP-6-028-S003-2)

28 PLCC Z86C34–C35 N/A 28 PLCC emulation pod

40 PDIP Z86C44–C45 N/A 40 PDIP emulation pod

44 PLCC Z86C44–C45 N/A 44 PLCC emulation pod

44 QFP N/A N/A N/A

Table 2.  Z86C5120GSE ICE Chip Supported Products (Z86C3600ZEM 
Target Emulator Selection)

Packages Emulation OTP Required Accessories

28 PDIP Z86C36 N/A 28 PDIP emulation pod
UM002202-1001   Introduction
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The Z86C3600ZEM becomes the Z86C3500ZEM when you use 
a Z86C50 ICE chip.

28 SOIC Z86C36 N/A 28 PDIP emulation pod and a DIP to SOIC 
conversion adapter from Emulation Technology (AS-
DIP-6-028-S003-1 or AS-DIP-6-028-S003-2)

28 PLCC Z86C36 N/A 28 PLCC emulation pod

40 PDIP Z86C46 N/A 40 PDIP emulation pod

44 PLCC Z86C46 N/A 44 PLCC emulation pod

Table 2.  Z86C5120GSE ICE Chip Supported Products (Z86C3600ZEM 
Target Emulator Selection)  (Continued)

Packages Emulation OTP Required Accessories

Notes:
Introduction   UM002202-1001
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HARDWARE SPECIFICATIONS

Operating Conditions

Operating Humidity: 10%-90% RH (Noncondensing)

Operating Temperature: 20 °C ±10 °C

Clocks: The control processor operates at 7.3728 
Mhz; the emulation processor operates at 
16.384 Mhz 

Serial Baud Rate: 57,600 bps

Power Requirements

This ICEBOX requires an external 5VDC power supply.

Operating Voltage (Input): +4.75 VDC to +5.25 VDC Max 
(+5.0 VDC typical) 

Operating Voltage (Target): +3.0 VDC to +5.5 VDC Max 

Operating Current: 2.5 A typical (maximum 3.0 A)

Serial Interface

ZiLOG Developer Studio communicates with the Z86C36 ICEBOX using 
a DB25, RS-232 and DCE cable (TxD, RxD only).

GUI-SUPPORTED COMPILER, ASSEMBLER FORMATS

The ICEBOX supports object (binary or Intel hex) code files produced by 
ZiLOG Developer Studio (ZDS) and ZiLOG Macro Cross Assembler 
(ZMASM).
UM002202-1001   Introduction
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KIT CONTENTS

The ICEBOX kit contains one of each of the following items:

• Z86C36 ICEBOX

• 40 PDIP emulation pod with cable ZiLOG: 93C0024-001

• 44 PLCC emulation pod ZiLOG PC: 99C0273-001

• 28 PDIP emulation pod ZiLOG PC: 99C0742-001

• 28 PLCC emulation pod ZiLOG PC: 99C0512-001

• Power Cable with Banana Plugs

• RS-232 Serial Cable, DB 25

• ZiLOG Developer Studio Installation CD

• Z86C36 ICEBOX User Manual

• ZiLOG Developer Studio manual contained on the ZDS installation 
CD-ROM. 

If the ZDS CD-ROM does not contain the manual, it can be 
downloaded from the ZiLOG web page at www.zilog.com. 

Additional Items Not Supplied

The following item is required but are not currently supplied in the 
ICEBOX kit:

• A source of power (+5 VDC typical) for the ICEBOX. This can be a 
laboratory power supply with current rating of at least 2.5 ampere.

Note:
Introduction   UM002202-1001
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Optional Recommended Item

The following items are recommended:

• Your target design. The target design is a wire-wrapped or printed 
circuit prototype that includes a socket for the target device that the 
ICEBOX cable/pod plugs into.

• C-Compiler 

Contact a ZiLOG Sales Office or Distributor to order a copy of the 
Z8 C-Compiler. Refer to our website for a representative near you: 
http://www.zilog.com/sales/. 

• Oscilloscope

• Logic Analyzer

COMPUTER REQUIREMENTS

Minimum Requirements

• IBM PC (or 100-percent compatible) Pentium based machine

• 75 MHz or more with 16 MB RAM

• VGA Video Adapter

• Hard Disk Drive (12 MB free space)

• CD-ROM Drive   (a CD-ROM drive is not needed if you download 
ZDS from the web at www.zilog.com)

• RS-232 COM Port

• Mouse or Pointing Device

• Microsoft Windows 95/98/NT

Note:
UM002202-1001   Introduction
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The following enhancements to the minimum requirements are 
recommended:

• 166-MHz IBM PC

• SVGA video adapter

• Printer

CONTACTING ZILOG CUSTOMER SUPPORT

ZILOG has a worldwide customer support center located in Austin, 
Texas. The customer support center is open from 7 a.m. to 7 p.m. Central 
Time.

The customer support toll-free number for the United States and Canada 
is 1-877-ZiLOGCS (1-877-945-6427). For calls outside of the United 
States and Canada dial 512-306-4067. The FAX number to the customer 
support center is 512-306-4072. Customers can also contact the support 
center through our website at http://www.zilog.com/support/. 

For valuable information about hardware and software development tools, 
go to ZiLOG home page at http://www.zilog.com. The latest released 
version of the ZDS can be downloaded from this site.
Introduction   UM002202-1001
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2 Setup and Installation

HARDWARE INSTALLATION

Before installing the hardware, refer to Figure 1 for a diagram on 
connecting the ICEBOX to a PC and power supply. Figure 2 provides 
option jumper locations.

Quick Installation Instructions

To install the hardware using a bench power supply, perform the 
following. 

1. Set the correct jumper setting for powering the ICE chip and target 
board. See Set Power Jumper on page 12.

2. Connect the power supply to the emulator and ensure it is set to 
provide + 5.0 V and 2.5 A.

3. Connect the serial cable to the PC.

4. Connect the ICEBOX to the target board (if performing in-circuit 
emulation).

5. Set up the oscillator and option jumpers.

6. Select the ICE chip that you want to emulate.

7. Power up the ICEBOX.

2

UM002202-1001   Setup and Installation



Z86C36
ICEBOX

10
Figure 1. Hook-Up Diagram

Each ICEBOX is shipped with a 16.384 MHz oscillator. The user 
can also use the target’s oscillator or a crystal/ ceramic resonator 
to clock the ICE chip, for more information see Jumper Settings 
on page 20.

+-

Note:
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Figure 2. Z86C36 ICEBOX External Top View

RS-232C Power Reset

LEDS

Target Pod 

Logic analyzer connector*

Debug 
pins

J2

J3

J7

Voltage 
adjuster

J5 J6

Oscillator 

Reset 

J1

ICE chip ziff 
socket 

U1

*This is not supported.
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Complete Installation Instructions

The following procedures illustrate a complete step-by-step guide on 
installing the ICEBOX.

Set Power Jumper

The Z86C36 ICEBOXes allow the user to power the ICEBOXes and 
target from a variety of different sources. Before powering the ICEBOX 
the user should select the power configuration.

The procedures below must be followed exactly as described.
Before beginning the procedures study Figure 3, which shows a
schematic of the J1 power jumper. Failure to follow the proce-
dures will result in total damage to the ICEBOX or target. 

Choose from one of the following options when selecting the power 
source:

• Jumper pin 1 to pin 2 to power the ICE chip with the ICEBOX’s 
adjustable regulator

• Jumper pin 3 to pin 4 to power target with the ICEBOX’s adjustable 
regulator

• Jumper pin 1 to pin 2 and pin 3 to pin 4 to power both the ICE chip 
and target from the ICEBOX’s adjustable regulator

• Jumper pin 2 to pin 4 to power the ICE chip from the target

When powering the target from the ICEBOX ensure that the 
target’s power supply is disconnected. 

Caution:

Note:
UM002202-1001   Setup and Installation
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Figure 3. J1 Jumper Schematic

Connect the Power Supply

1. If the power supply allows voltage adjustment:

– Turn the power supply on and adjust it to +5 V

– Adjust the limiting adjustment, if present, to at least 2.5 A

2. Turn the supply off.

3. Locate the power cable (red wire, black wire, and banana plugs on the 
other end). Plug in the black banana plug into the black jack on the 
power supply (labeled COM, GND, or with the ground symbol). Plug 
the red plug into the red jack on the power supply (labeled +, + V or 
+5 V).

4. Plug the white connector on the other end of the cable into the 
matching 4-pin connector on the back side of the ICEBOX. This 
connection is keyed to ensure against an improper connection.

The ZiLOG Power Supply Accessory Kit (ZPS05V00ZAC), 
which is sold separately, provides a fixed-5 V Universal Output 
Power Supply, accepts 110 V to 220 V AC input, and includes a 
power cable and an in-line jack cable.

Always check the supply voltage before plugging in the power
cord.

Target

ICEBOX Adjustable
Voltage Regulator

21

3 4

ICE chip

Note:

Caution:
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Connect the Serial Cable to the PC

Locate the serial cable. Connect the male end to the female connector on 
the back of the ICEBOX, and the female end to either the COM1, COM2, 
COM3, or COM4 connector of the host PC, see Figure 1.

If connector availability is limited to a 9-pin COM1 through 
COM4, then use either a different cable or a 25-pin to 9-pin 
converter. This converter is available at any electronics store for a 
nominal fee.

Connect to the Design

Perform the following steps to connect to the target design:

Wear a properly grounded wrist strap or similar ESD protection
before continuing.

1. Locate the emulation cable for the device.

2. Plug the cable into the target device. Ensure that the pin 1 marking (as 
indicated by the red mark on the ribbon cable) matches pin 1 on the 
target board. 

3. Plug the other end of the cables into target pod on top of the 
ICEBOX. See Figure 2 for the location of the target pod.

4. Select the power source for the ICE chip by configuring the J1 
jumper. See Table 4 for more information on jumper settings and 
Figure 2 for the location of the J1 jumper.

5. If the target and ICEBOX are using separate power supplies, ensure 
that the ICE chip voltage matches the target’s device voltage. Adjust 
the voltage by performing the following steps: 

a. Measure the voltage of your target. 

b. Locate the voltage adjuster on top of the ICEBOX. See Figure 2 
for the location of the voltage adjuster

Note:

Caution:
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c. Attach the voltmeter lead to either pin 1 or 3 on the J1 jumper and 
ground.

d. Power the ICEBOX with the target device disconnected.

e. Turn the voltage adjuster’s screw until the voltmeter’s read-out 
matches the target device’s voltage.

Failure to match the target devices voltage with the ICE chip’s
voltage could result in damage to the ICEBOX, target device, or
ICE chip.

Power the ICEBOX

If anything unusual (such as an unexpected sound and/or smell) occurs 
when turning on the power supply, turn off the power supply and check 
the setting for the J1 jumper. See Set Power Jumper on page 12. If the 
power supply allows voltage adjustment, adjust it again to +5 V. The 
power supply output may measure less than +5 V because of the load of 
the ICEBOX. If your power supply has a current meter, ensure that the 
ICEBOX is drawing within the rated current.

After power-up, press the RESET button to reset the ICE chip. (Pressing 
the RESET button avoids bus contention on the I/O lines.) If the ICEBOX 
is not powering your design through the VCC pin, turn on the power 
supply of the design.

If your design already has a power supply, do not power your
design from the ICEBOX VCC pin.

When powering down, follow the procedure described below:

1. Halt emulation.

2. In ZDS select Reset from the Build or Debug Menu.

3. Power down the target application board (if using its own power 
supply).

4. Power down the ICEBOX.

Caution:

Caution:
Setup and Installation   UM002202-1001
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Refer to the complete Electrical Safeguards shown in the preface 
of this manual.

Installing a New ICE Chip

The Z86C36 ICEBOX comes with the Z86C51 ICE chip. Under ordinary 
circumstances, the user should never have to remove this ICE chip. If for 
some reason the ICE chip needs to be replaced, follow the procedures 
below. See Figure 4 and Figure 5 for more information.

Replace the Z86C51 ICE chip with the Z86C50 ICE chip to 
support devices with 32K code size or less. 

Failure to follow the procedures below could result in damage
to the ICEBOX.

Perform the following steps to replace the ICE chip.

1. Disconnect all power to the ICEBOX

2. Move the ICEBOX ziff socket labeled U1 to the upright position and 
remove the ICE chip. See Figure 2 for the location of the ziff socket.

3. Place the new ICE chip into the U1 ziff socket. Ensure that the ICE 
chip’s pin 1 matches pin 1 on the U1 ziff socket. 

4. Close the ziff socket locking lever.

A dot in the corner of the processor indicates the chip’s pin 1 
location.

Note:

Note:

Caution:

Note:
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Figure 4. ICE Chip Installation
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Figure 5. Closing the ICE Chip Locking Lever

SOFTWARE INSTALLATION

For more information on installing ZDS, refer to the user manual that is 
included on the installation CD-ROM or download ZDS literature from 
the ZiLOG web page at www.zilog.com.

ICEBOX OPERATION

The following topics guide the user on how to operate the ICEBOX and 
configure jumper settings.
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Resetting

Press the RESET button on the ICEBOX to reset the state of the target 
device and the status that was established using ZDS. 

For example, the ICEBOX sets the program counter to 000Ch.

After reset, wait until the Ready LED is ON and has finished blinking 
before starting ZDS. Refer to the LED Operation section of this chapter 
for more details.

Always press the RESET button on the ICEBOX before starting 
ZDS.

LED Operation 

ZiLOG ICEBOXes use LEDs to communicate the different hardware 
states. The following table gives a description of the LEDs. The 
ICEBOX’s LED’s are located on the right front of the ICEBOX. See 
Table 3.

Table 3.  Front LED Assignments

LED Indication Description

READY On
Off

Communicating in Bisync Mode and waiting for command
Communicating in ASCII Mode or executing Bisync command

RUN On
Off

Running user code
Not running user code

OTP On
Off

The ICEBOX is performing OTP programming
The ICEBOX completed OTP programming

PWR On
Off
Blink

ICEBOX is powered up and Self Test is completed
Power is off
ICEBOX is self-testing

Note:
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Jumper Settings 

Table 4 lists jumper setting that the are easily configured by the user. See 
Figure 2 for the location of the jumpers.

Port 3 pin 4 can be used as an output pin or an external memory 
indicator. If P3.4 is used for external memory and not data 
memory, then jumper pin 2 to pin 4 on the J6 jumper.

Table 4.  Jumper Settings

Jumper Pin Position Description

J1 1-2 In Powers the ICE chip with ICEBOX’s adjustable voltage 
regulator (default), for more information see Figure 3

J1 3-4 In Powers the Target with ICEBOX’s adjustable voltage regulator

J1 2-4 In Target powers the ICE chip

J2 1-2 In Y2 Crystal to XTAL2

J2 2-3 In User Crystal to XTAL2

J3 1-2 In Y2 Crystal to XTAL1

J3 2-3 In User Crystal to XTAL1

J3 2-4 In Canned Oscillator to XTAL1 (Default)

J5 1-2 In Not installed (factory settings)

J6 2-4 In Enable if P3.4 used for external memory/DM (see note)

J6 2-3 In P3.4 not used (default)

J6 1-2 In Ground signal

J7 1-2 In Default setting

J7 2-3 In Output of PAL (Programable Array Logic)/not used

Note:
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The user can adjust the voltage of the ICE chip to match the target’s 
voltage using the ICEBOX’s R55 Voltage Adjuster. See Figure 2 for the 
location of the voltage adjuster.
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3 Overview

USING ZDS

This ICEBOX is fully compatible with ZiLOG Developer Studio (ZDS) 
software. The following steps briefly describe the procedures necessary to 
setup and create projects with the Z86C36 ICEBOX. A summary of the 
ICEBOX’s available debug windows is also included at the end of this 
chapter.

For more detailed information on using ZDS, refer to the ZDS User 
Manual (in PDF format) located on the installation CD-ROM, or 
download the latest information from our web site at www.zilog.com.

Select the ICEBOX

Perform the following steps to select the ICEBOX and create a new 
project:

1. Open ZDS by selecting Start>Programs>Zilog Developer Studio> 
ZDS.

2. Choose New Project from the File menu. The New Project dialog box 
appears as show in Figure 6. 

If the project has already been created, select Target from the 
Project menu and perform the following steps that are applicable 
for the ZiLOG MCU Database dialog box.

Note:

3
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Figure 6. New Project Dialog Box

3. Select Family in the Selection by field.

4. Select Z8 from the Master pop-up list.

5. Select a microcontroller from the Z8 family in the Project Target pop-
up list.

6. Select Z86C3500ZEM or Z86C3600ZEM in the Emulator pop-up 
list. 

The Z86C3600ZEM becomes the Z86C3500ZEM when you use a 
Z86C50 ICE chip.

7. Click on the browse button (...) in the Project Name field. The New 
Project Browser dialog box appears. 

8. Enter the project file name  and select a path in the New Project 
Browse dialog box.

Z86C3500ZEM

Note:
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All build output files, such as linker and assembly files are saved 
in the same directory as the project.

9. Click Save. The project name appears in the Project Name field in the 
New Project dialog box.

10. Click on Chip Data to view the microcontroller specifications. 

Fields in the Chip Data page are read-only and can not be 
modified.

11. Click OK. The new project is saved as the name specified in the New 
Project Browse dialog box.

12. Select Emulator Configuration from the Project menu. The Emulator 
Configuration dialog box appears, as shown in Figure 7.

Figure 7. Emulator Configuration Dialog Box

Note:

Note:
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13. Ensure that Emulator is selected in the Module field. 

14. Select the port the ICEBOX is connected to from the Port pop-up list.

15. Select 57600 from the Baud Rate pop-up list.

16. Click OK to close and apply the Emulator Configuration options.

17. Select Save Project from the File menu to save the emulator 
configuration setting. 

Open a Project and Add Files

A previously created project has the following attributes saved with it:

• Target settings

• Assembler and Linker settings for the specified target

• Source files (including header files)

Use the Project Viewer window to view and access the various 
files in any given project.

Perform the following steps to open a previously created project:

1. Select Open Project from the File menu. The Open Project dialog box 
appears. 

2. In the Open Project dialog box, select the previously created project. 
The project appears in the Project Viewer window, as shown in 
Figure 8.

Note:
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Figure 8. Project Viewer Window

Add an Existing File

Perform the following steps to add an existing file to a project:

1. Select Add to Project>Files from the Project menu. The Insert Files 
into Project dialog box appears, as shown in Figure 9.

Figure 9. Insert Files into Project Dialog Box

2. Select the file to add to the project. 
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3. Click Open. The file appears in the Project Viewer window, as shown 
in Figure 10.

Figure 10. Project Viewer Window with File

4. Double-click on the file in the Project Viewer window. The file 
appears in the ZDS main Edit window.

In some cases, non-editable files, such as .obj files need to be 
included in a project. These files are displayed in the source file 
list, but cannot be opened. When the project is built, these files are 
automatically linked.

5. Select Update All Dependencies from the Build menu. The 
Dependencies folder list in the Project Viewer window is updated.

Add a New File

1. Select Add to Project>New from the Project menu. The Insert New 
Files Into Project dialog box appears.

2. Type a file name in the File Name field. 

3. Click Open. The new file name appears in the Project Viewer window 
with a .asm suffix, and a blank Edit window also appears.

Header and Included files do not have to be added. The program 
detects those called by the source code.

Note:

Note:
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Table 5 lists the debug windows that are available using ZDS.
Table 5.  Debug Windows

Window Function            Updated values display in red

Watch • Shows the symbols and the contents of the registers�(see the
ZDS user manual for more information)

Z8 Standard Registers • Shows the contents of the Z8 standard registers 

Code Memory • Allows the user to monitor, edit, and download a .ld file
or a .hex file into Code Memory from generated assembly
source code 

• Tracks a specific address entered in the Code Address edit
box

Disassembly • Shows code memory along with the corresponding
disassembled code 

• Allows the user to edit, and download a file.ld or file.hex
into the Code memory   

• Follows the program counter 

• Provides a complete scroll down with this window,
however the scroll up is limited

• Accesses the disassembly of code at the address specified in
the Code Address field 

• The Disassembly window is automatically displayed when
debugging hex code or whenever there is no corresponding
source file available at the address specified by the program
counter
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Z8 Register File • Shows all Z8 internal and external registers, all RAM
pointer and data registers, status registers and status flags,
and stacks 

• Monitor and edit write-able registers in this window

Z8 Expanded Register • Displays the Z8 Expanded Register banks that are specified
in the configuration 

• Monitor and edit write-able registers directly in this window
by selecting a specific bank tab 

Working Registers • Modify and view working registers in this window

Timer Counter Registers • Modify and view the timer/counter registers in this window

Ports Register • Monitor and edit port registers in this window 

Table 5.  Debug Windows  (Continued)

Window Function            Updated values display in red
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Appendix A: Troubleshooting Guide

INTRODUCTION

Before contacting a ZiLOG representative or submitting a Problem 
Report, please follow these simple steps. Also, check the Precautions and 
Limitations sections in the Product Information document included with 
the emulator to eliminate other possible known problems. If a hardware 
failure is suspected, contact a local ZiLOG representative for assistance.

ERROR OPENING SERIAL PORT

If the initial ZiLOG screen is not appearing after selecting the COM port 
and the screen message displays Time-out while reading:

1. Check the RS-232C cable connection and communication port 
selection in ZDS. See Select the ICEBOX on page 23 for more 
information on how to configure the host PC’s port.

2. Reset the emulator and ZDS. 

3. Try connecting another cable.

4. Check if transmit/receive signals need to be swapped.

On some DB9 connectors for the COM ports, the transmit/receive 
signal may be swapped and a Null Modem adapter may be 
required.

5. Ensure that the power supply is connected, is turned on, and power is 
available.

6. Ensure that the power supply is set at the correct voltage.

Note:
UM002202-1001   Appendix A: Troubleshooting Guide



Z86C36
ICEBOX

32
7. Ensure that the J1 power jumper has been properly configured. See 
Set Power Jumper on page 12 for more information on setting the J1 
jumper.

8. Check if power supply is supplying the required current (2.5 A 
typical) to the emulator.

9. Check selected the port using another application or select another 
COM port.

10.  After resetting the emulator, wait a minimum of 5 seconds before 
running ZDS.

COUNTER JUMPS TO UNEXPECTED ADDRESS

Any instruction other than a DI instruction is used to disable interrupts. 
Possible causes include:

• The stack overflows into the general register locations.

• Extra POP, PUSH, IRET, or RET is encountered (stack unbalanced).

• Program resets repeatedly.

– Program counter rolls over from value FFFF to 0000 and 
proceeds back to the beginning of program.

– Watch-Dog Timer (WDT) is not initialized or refreshed.

• Unintialized interrupt vector is activated. The interrupt vector is not 
set to the interrupt handler.

ZDS ERROR MESSAGES

Can Not Open Windows 

If this message appears while attempting to open a window ZDS, there 
may not be enough memory within the Microsoft Windows environment 
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to properly run ZDS. Try closing the other active applications or exit and 
re-enter the Microsoft Windows environment.

Out of Synchronization with the Emulator

This message appears whenever communication between the emulator 
and the PC is interrupted.

1. Ensure that the power cable is connected.

2. Ensure that the RS-232C cable is connected.

3. Change the baud rate setting (default is 19200). A lower setting 
usually improves communications reliability. 

4. Reestablish communication between ZDS and the emulator. See the 
ZDS on-line help for more information on establishing 
communication with an emulator.
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Appendix B: ASCII Character Set

Table 6.  ASCII Character Set

Graphic Decimal Hexadecimal Comments

0 0 Null

1 1 Start Of Heading

2 2 Start Of Text

3 3 End Of Text

4 4 End Or Transmission

5 5 Enquiry

6 6 Acknowledge

7 7 Bell

8 8 Backspace

9 9 Horizontal Tabulation

10 A Line Feed

11 B Vertical Tabulation

12 C Form Feed

13 D Carriage Return

14 E Shift Out

15 F Shift In

16 10 Data Link Escape

17 11 Device Control 1

18 12 Device Control 2
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19 13 Device Control 3

20 14 Device Control 4

21 15 Negative Acknowledge

22 16 Synchronous Idle

23 17 End Of Block

24 18 Cancel

25 19 End Of Medium

26 1A Substitute

27 1B Escape

28 1C File Separator

29 1D Group Separator

30 1E Record Separator

31 1F Unit Separator

32 20 Space

! 33 21 Exclamation Point

" 34 22 Quotation Mark

# 35 23 Number Sign

$ 36 24 Dollar Sign

% 37 25 Percent Sign

& 38 26 Ampersand

’ 39 27 Apostrophe

( 40 28 Opening (Left) Parenthesis

) 41 29 Closing (Right) Parenthesis

Table 6.  ASCII Character Set  (Continued)

Graphic Decimal Hexadecimal Comments
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* 42 2A Asterisk

+ 43 2B Plus

, 44 2C Comma

- 45 2D Hyphen (Minus)

. 46 2E Period

/ 47 2F Slant

0 48 30 Zero

1 49 31 One

2 50 32 Two

3 51 33 Three

4 52 34 Four

5 53 35 Five

6 54 36 Six

7 55 37 Seven

8 56 38 Eight

9 57 39 Nine

: 58 3A Colon

; 59 3B Semicolon

< 60 3C Less Than

= 61 3D Equals

> 62 3E Greater Than

? 63 3F Question Mark

@ 64 40 Commercial At

Table 6.  ASCII Character Set  (Continued)

Graphic Decimal Hexadecimal Comments
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A 65 41 Uppercase A

B 66 42 Uppercase B

C 67 43 Uppercase C

D 68 44 Uppercase D

E 69 45 Uppercase E

F 70 46 Uppercase F

G 71 47 Uppercase G

H 72 48 Uppercase H

I 73 49 Uppercase I

J 74 4A Uppercase J

K 75 4B Uppercase K

L 76 4C Uppercase L

M 77 4D Uppercase M

N 78 4E Uppercase N

0 79 4F Uppercase 0

P 80 50 Uppercase P

Q 81 51 Uppercase Q

R 82 52 Uppercase R

S 83 53 Uppercase S

T 84 54 Uppercase T

U 85 55 Uppercase U

V 86 56 Uppercase V

W 87 57 Uppercase W

Table 6.  ASCII Character Set  (Continued)

Graphic Decimal Hexadecimal Comments
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X 88 58 Uppercase X

Y 89 59 Uppercase Y

Z 90 5A Uppercase Z

[ 91 5B Opening (Left) Bracket

\ 92 5C Reverse Slant

] 93 5D Closing (Right) Bracket

^ 94 5E Circumflex

_ 95 SF Underscore

‘ 96 60 Grave Accent

a 97 61 Lowercase A

b 98 62 Lowercase B

c 99 63 Lowercase C

d 100 64 Lowercase D

e 101 65 Lowercase E

f 102 66 Lowercase F

g 103 67 Lowercase G

h 104 68 Lowercase H

i 105 69 Lowercase I

j 106 6A Lowercase J

k 107 6B Lowercase K

1 108 6C Lowercase L

m 109 6D Lowercase M

n 110 6E Lowercase N

Table 6.  ASCII Character Set  (Continued)

Graphic Decimal Hexadecimal Comments
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o 111 6F Lowercase O

p 112 70 Lowercase P

q 113 71 Lowercase Q

r 114 72 Lowercase R

s 115 73 Lowercase S

t 116 74 Lowercase T

u 117 75 Lowercase U

v 118 76 Lowercase V

w 119 77 Lowercase W

x 120 78 Lowercase X

y 121 79 Lowercase Y

z 122 7A Lowercase Z

{ 123 7B Opening (Left) Brace

| 124 7C Vertical Line

} 125 7D Closing (Right) Brace

~ 126 7E Tilde

127 7F Delete

Table 6.  ASCII Character Set  (Continued)

Graphic Decimal Hexadecimal Comments
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Appendix C: Problem/Suggestion 
Report Form

If you experience any problems while operating this product, or if you note any inac-
curacies while reading the user manual, please copy this form, fill it out, then mail or 
fax it to ZiLOG. We also welcome your suggestions!

Customer Information

Product InformationReturn Information

Problem Description or Suggestion
Provide a complete description of the problem or your suggestion. If you are reporting a specific 
problem, include all steps leading up to the occurrence of the problem. Attach additional pages as 
necessary.
_______________________________________________________________________________

______________________________________________________________________________

_______________________________________________________________________________

Name Country

Company Telephone

Address Fax Number

City/State/ZIP E-Mail Address

Serial # or Board Fab #/Rev. # ZiLOG, Inc.

Software Version System Test/Customer Support

Manual Number 910 E. Hamilton Ave., Suite 110, MS 4-3

Host Computer Description/Type Campbell, CA 95008

Fax Number: (408) 558-8536

Email: tools@zilog.com
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Glossary

ASCII American Standard Code of Information 
Interchange.

Baud Unit of measure of transmission capacity. 

Binary Number system based on 2. A binary digit is a bit.

BISYNC Bidirectional Synchronous Communication
Protocol.

Bit A digit of a binary system. It has only two possible 
values: 0 or 1.

BPS Bits Per Second. Number of binary digits transmitted
every second during a data-transfer procedure.

Bus In Electronics, a parallel interconnection of the 
internal units of a system that enables data transfer
and control Information.

Byte A collection of four sequential bits of memory. Two
sequential bytes (8 bits) comprise one word.

COM Device name used to designate a communication
port.

DIP Dual In-line Package. The plastic housing designed 
to be attached directly to a circuit board or equipment
case.
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Emulation Process of duplicating the behavior of one product or 
part using another medium. 

Emulator An emulation device. For example, an In-Circuit 
Emulator (ICE) module duplicates the behavior of 
the chip it emulates in the circuit being tested.

GUI Graphical User Interface. The windows and text that 
a user sees on their computer screen when they are 
using a program.

ICE In-Circuit Emulator. A ZiLOG product which 
supports the application design process.

Icon A small screen image representing a specific 
element like a document, embedded and linked
objects, or a collection of programs gathered
together in a group.

Initialize To establish start-up parameters, typically involving 
clearing all of some part of the device’s memory 
space.

Instruction Command.

I/O Input/Output. In computers, the part of the system 
that deals with interfacing to external devices for 
input or output, such as keyboards or printers.

MCU Microcontroller or Microcomputer Unit. 

OTP One-Time Programmable.

PC Personal computer, program counter.
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POP Retrieve a Value from the Stack.

Port The point at which a communications circuit termi-
nates at a Network, Serial, or Parallel Interface card.

PUSH Store a Value In the Stack.

RA Relative Address.

RAM Random-Access Memory. A memory that can be 
written to or read at random. The device is usually 
volatile, which means the data is lost without power.

RS-232C Electronic Industries Association Standard for 
Asynchronous Transmissions Between a Computer
and a Peripheral Device.

SOIC Small Outline IC.

SVGA Super Video Graphics Adapter.

TMR Timer Mode Register.

UART Universal Asynchronous Receiver Transmitter.
Component or functional block that handles 
asynchronous communications. Converts the data 
from the parallel format in which it is stored, to the 
serial format for transmission.

V Volt, Overflow Flag.

VCC Supply Voltage.
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WDT Watch-Dog Timer. A timer that, when enabled under
normal operating conditions, must be reset within the
time period set within the application (WDTMR 
(1,0)). If the timer is not reset, a Power-on Reset 
occurs. Some earlier manuals refer to this timer as the 
WDTMR.

Word Amount of data a processor can hold in its registers 
and process at one time. A DSP word is often 16 bits. 
Given the same clock rate, a 16-bit controller 
processes four bytes in the same time it takes an 8-bit 
controller to process two.

XTAL Crystal.

Z8 ZiLOG Chip.

ZDS ZiLOG Developer Studio. ZiLOG’s program 
development environment for Windows 95/98/NT.

Z locatable object modules for the ZiLOG family of
microcontrollers.

ZMASM ZiLOG Macro Cross Assembler. ZiLOG’s program
development environment for Windows 3.1.
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E2
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F3
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G2
G3
G1
H1

B5
C5
B4
A3
A2
C4
B3
A1

B8
A8
B7
C7
A6
B6
C6
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C3
B2
B1
D3
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D2
D1

J3

M8
N8
L7
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M4
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L1

K2

K3

K4

D4

K1
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N1

L3L5

H2

J1

J2

M1

L8

N11

M9

M10
L9

N12
L10
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N13

K10

L11
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M13
K11
L12
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K12
J11

K13
J12

C11

B12
A12
C10
B11
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B10

C9
A10

B9
A9
C8

N10
E3
D13
A4A7

J13
N9

F1

H11
H12
H13
G12
G11
G13
F13
F12

E13
E12
E11
D12
C13
B13
D11
C12

H3

N7

F11
A13

P10
P11
P12
P13
P14
P15
P16
P17

P20
P21
P22
P23
P24
P25
P26
P27

P00
P01
P02
P03
P04
P05
P06
P07

P30
P31
P32
P33
P34
P35
P36
P37

R/W

A0
A1
A2
A3
A4
A5
A6
A7
A8
A9

A10
A11
A12
A13
A14
A15

AS

DS

SYNC

WAIT

HALT

HOLD

STOP

IACK

MAS

MDSSMR

DM

RESET

DTIMERS

SCLK

ADMUX

XTAL1

XTAL2

IRQ3
IRQ4

RBP0
RBP1
RBP2
RBP3

SCLKN

IWD0
IWD1
IWD2
IWD3
IWD4
IWD5
IWD6
IWD7

REGWR
REGRD

CE_ERF

D0
D1
D2
D3
D4
D5
D6
D7

SIZE0
SIZE1
SIZE2

VCC_N10
VCC_E3

VCC_D13
VCC_A4GND_A7

GND_J13
GND_N9

GND_F1

RA0
RA1
RA2
RA3
RA4
RA5
RA6
RA7

IRD0
IRD1
IRD2
IRD3
IRD4
IRD5
IRD6
IRD7

GND_H3

GND_N7

CT0
TCLK

R
21

10
k

nIRQ3<3A1

SMR<3A3

nRESET<1E4;>3A3

T_P37<3A1

C50SZ[2..0]<1A3

UD[7..0]
<>1E3

MA[15..0] >1A1

nSTOP >3A3

nSYNC >1A4

nIACK
>1A4

nU_AS >4E4

nU_RESET>1A4

U_P1[7..0]
<>1E4

XTAL1>3A3

T_P30>3A2

U_P37>3A2

IRD[7..0] <3A4

IWD[7..0] >3A4

RBP[3..0] >3A4,>4A1

RA[7..0] >3A4,>4A3

nREGRD >3A4
nREGWR >3A4
nCE_ERF >3A4

SCLK >1A4;>3A3

U_D[7..0]<>1A4

nU_DS >1A4

nU_MDS >1A4

U_RW >1A4

U_P30<3A1

U_P2[7..0]>1A4

ICRAM<1E4
U_P0[7..0]>1E1

U_P3[7..0]>1E1

TCLK >4E4

nU_MAS >4E4

CLK_VCC
>1

CLK_TgtVcc1

Barbara E Lau
UM002202-1001                                                                                              Schematic-1



96C0620-00 1 B

Schematic, Z86C36 Daug hter Board

B

2 4Tuesday, July 27, 1999

Title

Size Document Number Rev

Date: Sheet of

mU_P37
mU_P35
mU_P33
mU_P31
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mU_P34
mU_P32
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U_P32
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U_P33
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RBP1
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mU_P37
mU_P36
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lanREGRD
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lanREGWR lanREGWR
lanREGRD
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laRA7
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laRA1
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laIWD4
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laRA0
laRA2
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TCLK
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U_RW

nSYNC
mnIACK

mnIACK
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RA7
RA6
RA5
RA4
RA3
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IWD7
IWD6
IWD5

IWD3
IWD2
IWD1
IWD0

IWD4
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nREGRD
nREGWR
nCE_ERF

mnU_AS
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nU_M_DS
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1A2
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1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

C35

0.
1u

F

C34

0.
1u

F

C37

0.
1u

F

C36

0.
1u

F

C39

0.
1u

F

C38

0.
1u

F

C20

0.
1u

F

C30

0.
1u

F

C13

0.
1u

F

C17

0.
1u

F

C19

0.
1u

F

C10

0.
1u

F

C14

0.
1u

F

C18

0.
1u

F

C11

0.
1u

F

C9

0.
1u

F

C12

0.
1u

F

C16

0.
1u

F

C7

0.
1u

F

C6

0.
1u

F

C40

0.
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F

C15

0.
1u

F

C5

0.
1u

F

C8

0.
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F
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1

46
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8
9
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14
16
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22
23

7
18
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4
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15
21

28
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45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

IWD[7..0]<2A3

RA[7..0]<2A3

RBP[3..0]<2A3

U_P3[7..0]<2A3

ICRAM<2A3
nREGRD<2A3
nREGWR<2A3
nCE_ERF<2A3

mU_P1[7..0]<1E4

mU_P2[7..0]<1E3

mU_P3[7..0]>3A4

nIACK <2A1
nSYNC <2A1

U_RW <2A1
nU_AS <2A1
SCLK <2A1
TCLK <2E3
nU_MAS <2A1

mUD[7..0] <2A1

mMA[15..8] <1E1

U_P0[7..0] <2A1

mU_P0[7..0]>3A4

mnIACK >1E3
mnU_AS >1E3
mnSYNC >1E2
mSCLK >1E2

nSTOP <2A1

hvnRESET <1E3
nU_M_DS <1A1

laU_RW >1E3
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SIZE4
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MA0
MA1
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MA3
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MA6
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MA8
MA9
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MA13
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U_D1
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U_D4
U_D5
U_D6
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mUD6

mUD4

mUD7
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mUD1
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mU_P15
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mUD2
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mU_P16
mU_P17
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mU_P11
mUD0
mUD1

mUD7
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mU_P12

mUD6
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mU_P10
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mUD6
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mU_P13
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mU_P17
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nU_RESET
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hvnRESET
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mICRAM
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hvnRESET
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U_P24
U_P23
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U_P20

U_P27
U_P26
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nU_DS

mU_P26
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mU_P24
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mU_P22
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mU_P27
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mMA14
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mMA13

mMA9

mMA13

mMA15

mMA8

mMA11

mMA11
mMA12

mMA14
mU_P07
mU_P06
mU_P05
mU_P04
mU_P03
mU_P02
mU_P01
mU_P00
mU_P37
mU_P36
mU_P35
mU_P34
mU_P33
mU_P32
mU_P31
mU_P30

mU_P27
mU_P26
mU_P25
mU_P24
mU_P23
mU_P22
mU_P21
mU_P20

mnIACK

mnU_AS
mSCLK
mnSYNC
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U_P11

U_P13

U_P15

U_P17

U_P14

U_P16

U_P10

U_P17

U_P13
U_P12

U_P10

U_P12

U_P15
U_P14

U_P11

U_P16

nCS_245

nCS_245
CS_245

BLKTGT

CH_DIR

nCH_DIR
BLKTGT

U_P34

nDM_BKOF
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1B3
1B4
1B5
1B6
1B7
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2B3
2B4
2B5
2B6
2B7
2B8
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45
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2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

J7

1 2 3

U10

QS3384

3

1
13

2412

4
7
8

11

2
5
6
9
10

14
17
18
21
22

15
16
19
20
23

A0

nLE
nHE

VCCGND

A1
A2
A3
A4

B0
B1
B2
B3
B4

A5
A6
A7
A8
A9

B5
B6
B7
B8
B9

R
28

10
k

R
27

10
k

U15

22V10

2
3
4
5
6
7
8
9

1

11

12
24

10

13
14
15
16
17
18
19
20
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22
23I2

I3
I4
I5
I6
I7
I8
I9

I/CLK

I11

Gnd
Vcc

I10

I13
IO14
IO15
IO16
IO17
IO18
IO19
IO20
IO21
IO22
IO23

U11
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6
8
9
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14
16
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22
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7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

MA[15..0]<2E4

U_P1[7..0] <>2A4

U_D[7..0]<>2A3

nU_DS<2E3

nU_RESET<2A1

ICRAM>2A3
C50SZ[2..0]>2A4

nU_MDS<2E3

mU_P3[7..0]<2A1

U_P2[7..0]<2A3

mU_P0[7..0]<2A1

mnIACK
<4E3

mnU_AS <4E3

mnSYNC <2A1

hvnRESET
>4E3

nU_M_DS>4E3

UD[7..0] >2A4

mU_P2[7..0]
>4A4

mUD[7..0]
>4E2

mMA[15..8] >4E2

mU_P1[7..0] >4A4

U_P34<1A2

CLK_VCC<2E3

CLK_TgtVcc2
nRESET<>2A3;>3A3

laU_RW
< 4E3

mSCLK <2A1
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IWD1
IWD0

nSTOP

nCE_ERF
IWD6

XTAL1

IWD4

TDO

nREGWR

IWD3

IWD5

SMR

nREGRD

IRD1

TDI

IRD6

IWD2

IRD2

IRD4

TCK

IRD0

IRD3

IRD7

IWD7

IRD5

SCLK

U_P30

RA3

RBP3

RA6

RBP0

RA2

RA5
RA4

RBP2
RBP1

RA1

RA7

RA0

T_P30
U_P37

T_P37

preU_P31

nIRQ3

TS

preU_P30
nRESET

U_P20
U_P21
U_P22
U_P23
U_P24
U_P25
U_P26
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TMS

Vcc

VccICE

Vcc

Vcc
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Vcc
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+ C86
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R50

10k

+ C85
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.1UF
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R57
1K

R56
1K

R59
1K

R58
1K

R55
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R54

169

R53

121

J5
1 2

+ C83

22uF

+ C82

10uF

P5
1
3
5
7
9

2
4
6
8
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.1UF

U7
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183
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101

162

100
157
156
105
155

84
103
158

160
98

154

97
126
99
125
32
130
131
137
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30
45
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20
24
31
35

182

34

21
124

163

79
49
108
78

123
33
96
104
165
86
88
161

4
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112
128
139
148

5
25
36
55
72
91

111
127
138
159
176
195

121

41
42
43
44
46
47
66

102
110
113
114
115
118

122
132
133
143

136

152
170
189
206

135

48

2
27

119

178
169
168
107
153

28
129

29

RBP0
RBP1
RBP2
RBP3

RESET

RA0
RA1
RA2
RA3
RA4
RA5
RA6
RA7

REGRD
REGWR
REGCE

IRD0
IRD1
IRD2
IRD3
IRD4
IRD5
IRD6
IRD7

VCC10
VCC19
VCC30
VCC45

GND14
GND20
GND24
GND31
GND35

SCLK

P37

IRQ3
T_P37/TX

T_P30/RX

TDI
TMS
TDO

TCLK

IWD0
IWD1
IWD2
IWD3
IWD4
IWD5
IWD6
IWD7

TriState

AUXCLK

VCC112
VCC128
VCC139
VCC148

VCC5
VCC25
VCC36
VCC55
VCC72
VCC91
VCC111
VCC127
VCC138
VCC159
VCC176
VCC195

GND121

GND41
GND42
GND43
GND44
GND46
GND47
GND66

GND102
GND110
GND113
GND114
GND115
GND118

GND122
GND132
GND133
GND143

GND136

GND152
GND170
GND189
GND206

CD

VPP

STOP
SMR

U_P30

P20
P21
P22
P23
P24
P25
P26
P27

+ C59

1uF

U21
LT1117CST-3.3

3

1

2VIN

A
D

J

VOUT

S1

SW M_ON

SCLK<2E3;>1A4
XTAL1<2A1

nSTOP<2E3

nCE_ERF<2E2

nREGWR<2E2

nREGRD<2E2

IWD[7..0]<2E2

T_P37>2A1

nRESET<1E4;<>2A3

SMR>2A3

nIRQ3>2A4

IRD[7..0]>2E2

U_P30>2A1

RA[7..0]<2E3

RBP[3..0]<2E2

T_P30<2A1
U_P37<2A1

U_P2[7..0]<2A1
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